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WHITE PAPER 

DRAN-VIEW 7 

Industry leading power analysis software provides professional reports and analysis for all users

INTRODUCTION 

Dran-View® 7 is a Windows-based software package 
that enables power professionals to simply and quickly 
visualize and analyze power monitoring data. It is easy 
to navigate, delivers automated functionality, and 
incorporates powerful analytical capabilities and 
customizable options to meet the needs of each 
individual user. With support in more than a dozen 
languages, Dran-View 7 is used by thousands of 
customers around the world and has become the 
industry leading power analysis software tool.  
 
Dran-View 7 is available in three versions: XP, Pro and 
Enterprise. Dran-View 7 XP has a reduced feature set 
and is only compatible with the DranXperT power & 
energy logger. Although all versions of Dran-View 7 
have the same base feature set, only Dran-View 7 Pro 
and Enterprise are highlighted in this white paper. 
Dran-View 7 XP is not included. 

DRAN-VIEW 7 PRO 

Dran-View 7 Pro is a great tool for any application, 
large, small, simple or complex. The advanced, yet 
simple to use feature set enables you to get the most 
out of your power survey. Features include trending of 
any recorded parameter in a stacked or overlaid 
format, analysis of any waveshape or event data 
recorded at any time, harmonic analysis, customizable 
displays, and many other features. Dran-View 7 Pro 
includes an advanced report writer, and even a Rescue 
Kit to help you undo mistakes made during your study, 
such as reversed CT’s, wrong time and more.  
 
Dran-View 7 Pro is typically included at no charge in 
Dranetz HDPQ Visa Plus and SP kits, but for a small fee 
users can upgrade to Dran-View 7 Enterprise.  

DRAN-VIEW 7 ENTERPRISE 

Dran-View 7 Enterprise includes all of the features 
found in Pro, plus additional features such as multiple 
site capabilities, mathematical channels to compute 
your own parameters, floating annotations, 
snapshots/favorites, additional file formats such as 
Comtrade & PQDIF, and much more.  
 
Dran-View 7 Enterprise is typically included at no 
charge in Dranetz HDPQ Guide, Xplorer and Xplorer 
400 Plus and SP kits.  
 

Note that some features discussed below are unique to 
Dran-View 7 Enterprise, so look for the “Pro” and 
“Enterprise” labels next to each.  
Many features described in this white paper include 
quick access by using the Dran-View 7 Ribbon located 
at the top of the display. In such cases, the associated 
Ribbon icon is shown.  
 

COMPATIBLE INSTRUMENTS 

Dran-View 7 XP is only compatible with the DranXperT 
power & energy logger. Dran-View 7 XP will not work 
with any other product and is not included in this 
white paper. 
 
Dran-View 7 Pro and Enterprise is compatible with all 
current, and many legacy Dranetz products, including: 
 
Dranetz HDPQ Family, DranXperT, PX5, PX5-400, 
Power 1000, PowerGuide, PowerVisa, PowerGuia, 
Energy Platform, Mavowatt (MW) 70, MW 70-400, MW 
50, MW 40, MW 30, MW 20, MW 230, MW 240, MW 270, 
MW 270-400, 4300, PP1, 8000-2, 8000, 658 
 
Dran-View 7 is also compatible with other Dranetz 
products, and those from other manufacturers when 
using file formats such as PQDIF, COMTRADE, csv, txt 
and others discussed below.  

DRAN-VIEW 7 USER INTERFACE – PRO, ENTERPRISE 

 

Figure 1 Dran-View 7 User Interface 

Dran-View 7’s interface is intuitive and easy-to-use, 
even for a first time user. Shown in Figure 1, you’ll see 
Dran-View 7’s two pane browser interface. Consider a 
‘pane’ as a window into any portion of your power 
survey. On the left side is the timeplot, or historical 
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view pane which enables you to trend any parameter 
over the entire recording period. The timeplot pane 
allows you to show trends in a stacked (shown) or 
overlaid format based upon your preference. On the 
right side is the data pane that shows details of any 
recorded event that’s selected. Details of events, such 
as waveshapes, measured data, etc., can be easily 
displayed in a graphical or textual format. By moving 
the splitter control bar, you can resize the windows to 
suit your needs. Simply drag the bar to the right to 
enlarge the timeline pane, or to the left to enlarge the 
data pane. Buttons are also available in the Ribbon to 
quickly maximize either pane or to make their sizes 

equal.  
 
By single clicking within a pane, that pane becomes 
the active pane. The active pane is indicated by a blue 
border around the perimeter of the pane. Being the 
active pane means that any functions, tools, views, 
etc. selected in the Ribbon act on that (active) pane.  
 
You can easily customize the contents and appearance 
to your liking by changing the properties (“right click”, 
properties) of each pane. Add or subtract parameters, 
change the color or line thickness of any trend or 
waveform, adjust the font size and details of the 
labeling, and much more.   
  

CONVENIENT ON SCREEN TOOLS  
EVENT CONTROLS – PRO, ENTERPRISE 

There are several ways to scan your event data. You 
can pull down the event list and randomly select any 
event of interest. Another, more visual approach is to 
use the Previous, Next and other event controls. 

Simply press the  (previous event) or  (next event) 
controls to view the change in the trend and 
waveshapes, and easily see the details of each event 
as you scan the list.  
 

 ZOOMING – PRO, ENTERPRISE 
Zooming is a fast and easy way to find data of interest. 
By using the mouse to draw a ‘zoom window’ on any 
trend or waveshape you can magnify that part of the 
display to the full size of the display window. Zoom in 
as many times as necessary to show the data of 
interest. Right click on the window to Zoom out, either 
one step at a time, or Zoom out entirely back to the 
original display in one step. 
 

PAN (LOCATED IN THE ZOOM PULL-DOWN) - ENTERPRISE    
Once you’ve zoomed in to data of interest, the Pan 
tool lets you slide that data window left or right in 
time without changing the zoom level. Simply select 
the Pan option (under Zoom) then drag the data in the 
window left or right to see information off the screen 
without changing the x and y axis.  
 

 

 

 

 DELTA TOOL – PRO, ENTERPRISE 

The Delta tool helps you measure the difference 
between two points on a trend or waveshape. Simply 
click the Delta tool button in the Ribbon, click and 
hold the mouse at the point you want to measure 
from, then drag the mouse to the point where you 
want to measure to. Both X and Y Delta measurements 
will be displayed. 

 
 

Figure 2 Delta Measurements 

DISPLAY APPEARANCE – PRO, ENTERPRISE 
 

 

Figure 3 Chart Properties 

Each trend or waveshape display can be customized to 
your liking. Just right click on the display and select 
Properties to adjust items such as the parameters and 
channels displayed, stacked or overlay plots, line 
style/color/thickness, fonts, legend, grid lines and 
more. 

With Dran-View 7 you can even change the channel 
names and labels to customize the display to your 
exact requirements. Maybe change the generic label ‘A 
Vrms’ to something directly related to your survey - 
‘Critical Bus 6 L1’. Right click on the channel label, 
select Properties and change the text to your liking.  
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DISPLAY OBJECTS – ENTERPRISE 

Dran-View 7 Enterprise unlocks the power of your user 
interface and displays each trend, event detail, phasor 
and table as a configurable ‘object’. Not only can you 
add or subtract any object, such as a trend, you can 
also rearrange the display and change the appearance 
to meet your needs.  
 
By selecting the Insert tab in the Ribbon you can add 
other elements, such as: 
- Charts: harmonics, magnitude-duration, etc. 
- Tables: min/max/average, energy, peak, etc. 
- Phasors diagram 
- More  

CONVENIENCE FEATURES & BENEFITS 

Dran-View 7 is more than just a viewer for power 
monitoring surveys. Dran-View 7 has many features and 
benefits that differentiate it from all other power 
monitoring software. The features below are examples 
of just some of what makes Dran-View 7 simple and 
convenient to use, yet provides an advanced feature 
set for even the most demanding of professional 
applications.  

 SNAPSHOT TOOL – ENTERPRISE 

Snapshots are similar to web site favorites and let you 
mark any number of trend or waveform views as 
favorites to easily access them in the future, 
maintaining the zoom level and other display 
adjustments. When you zoom in and locate the data of 
interest, simply press the Snapshot button in the 
Ribbon to save that view. On the left side of the 
display you’ll see a picture of your snapshot. Then, 
locate another event, adjust the display to your liking 
and click the Snapshot button again. You’ll see the 
new snapshot added to the snapshot list. Add as many 
snapshots as you like. To return to any snapshot simply 
double click on its picture on the left, and Dran-View 7 
will take you to that display. You can continue to 
adjust the display as you see fit.  

 

Figure 4 Snapshots 

MULTI-SITE - ENTERPRISE 

Many power surveys include more than one power 
monitor and need to compare data from two or more 
monitors at the same time. Common applications may 
be when measuring UPS’s, standby generator 
commissioning, multiple substations or feeds, power 
conditioning devices, etc. In such cases, the objective 
of the survey is to directly compare the data of two or 
more monitors at same time.  

When using Dran-View 7 Pro you can open multiple 
sites, but they are treated separately and not viewed 
simultaneously, so you must switch between them. A 
much more convenient and powerful method is found 
in the Multi-Site feature of Dran-View 7 Enterprise. 
With Multi-Site you can overlay data from multiple 
sites (up to 16) on one trend or waveform display, and 
even adjust the x axis (time) to make sure they are 
synchronized. When viewing Multi-Site data, each 
instrument’s data is maintained separately, but can be 
combined together in one trend, chart or event display 
for analysis.  

 

Figure 5 Viewing charts from multiple sites 

ANNOTATIONS AND PICTURES – ENTERPRISE 

A ‘picture speaks a thousand words’ and helps greatly 
to see what you’ve monitored. Dran-View 7 Enterprise 
enables you to add a diagram or photograph to any 
trend or waveshape window. For instance, a 
photograph of the damage done by a PQ problem, 
wiring diagram or other picture would help describe 
the event, and once added, is included in your Dran-
View 7 file. 

Annotations enable you to add your own comments at 
any point on a trend or waveform. Simply click on any 
waveform or trend to highlight it, right click at the 
point where you want the annotation and select Data 
Annotation. Double click on the annotation to change 
the text and properties such as font, etc.  

 

Figure 6 Data Annotation 
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 DATA TABLE EXPORTING – PRO, ENTERPRISE 

Many applications require exporting data to other 
software packages. An example is an energy 
application where electrical energy data collected 
during your power survey needs to be included in other 
software that combines data from other utilities such 
as gas, water, steam, etc. Dran-View 7’s data export 
function enables you to easily export in many common 
formats such as comma, tab and space delimited. You 
can also format the time in the saved file. Exported 
data can be saved to the Windows clipboard or a file. 
To export data from any trend or waveshape, click the 
data table icon in the Ribbon View tab. The data in the 
active pane will be displayed in a new tab in a tabular 
format. Right click on the table and select ‘Copy’ to 
save to the Windows Clipboard or ‘Save As’ to save in a 
file. In both cases a ‘Settings’ window will appear 
where you can select the export options mentioned 
above. 

PQDIF, COMTRADE & OTHER FORMATS – ENTERPRISE 

Many applications require the user to compare data 
from different monitoring systems. Dran-View 7 
Enterprise can read data from Dranetz or other 
manufacturer’s products by supporting the PQDIF, 
COMTRADE, text, csv and other file formats.  

PQDIF (Power Quality Data Interchange Format) or 
IEEE1159.3 is a universal file format used in the Power 
Quality industry and is common in fixed monitoring 
systems. Dran-View 7 can directly import compatible 
PQDIF files stored by any product, software or system. 
Simply select File->Open and change the file type to 
PQDIF, then open the file directly into Dran-View 7.   
     

COMTRADE files are commonly used in fault recorders 
and other utility applications for sampled waveform 
(oscillography) data. To import a COMTRADE file into 
Dran-View 7, select File->Open and change the file 
type to COMTRADE. Dran-View 7 will open the 
COMTRADE import wizard where you can identify each 
waveform and appropriate data labels and 
characteristics.  

Text files such as csv, txt, xls files are also supported 
by Dran-View 7. When importing Text files, select File-
>Open and change the file type to TEXT. Dran-View 7 
will open the ‘Text Import Wizard’ where you can set 
properties such as delimitation type (comma, tab, 
etc), time format and other items. 

 RESCUE KIT – PRO, ENTERPRISE 

Have you ever completed a power survey then realized 
that you had a CT connected backwards, the 
instrument time was wrong or had another human 
error?  The Dran-View 7 Rescue Kit can undo these 
types of mistakes made during your survey.  

 

 

Figure 7 Rescue Kit 

Some errors cannot be fixed, but the Rescue Kit can fix 
errors such as inverted current probes, improper scale 
factors and wrong time. The Rescue Kit can be found 
in the Ribbon Data tab.  

MATH CHANNELS - ENTERPRISE  

Dran-View 7 has a quite powerful Math channel feature 
that enables you to create your own computations 
from your measured data. Similar to the functions 
found in an Excel spreadsheet, Dran-View 7’s Math 
feature provides computational functions such as 
Mathematical (SQRT, PWR, etc), Trigonometric (SIN, 
COS, TAN, etc), logical (<, >, =, etc), Power (RMS, DFT, 
etc) and more. Math channels are created by applying 
formulas and computational functions to measured and 
computed data from your survey. 

 

Figure 8 Dran-View 7's Math Channels 

A simple example is a VA computation using the 
Voltage and Current measurements from your survey. 
VA is V x I, which is the basic formula you will create in 
the Math channel, as shown in Figure 8. Your custom 
VA computation is trended like any other parameter in 
Dran-View 7.       

A common application is to compute ground leakage 
current in a 3 phase wye circuit. In such cases, the 
current in phases A, B, C and Neutral are measured by 
the power monitor. Using Dran-View 7, you create a 
Math channel to compute leakage current by adding 
the current in phases A, B, C and Neutral, with the 
remaining current being leakage current. This feature 
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is like having a 5th current channel monitoring the 
ground current. 

You can create multiple Math channels, create a name 
for each channel with each having its own custom 
formula. 

REPORT WRITER – PRO, ENTERPRISE 

 

Figure 9 Dran-View 7 Report Writer 

Dran-View 7 has a built in report writer that enables 
you to produce professional custom reports that can 
include your company logo. All reports are created in a 
Word or .rtf format that’s compatible with most word 
processors, such as Microsoft Word. As a result, the 
report can be easily edited and annotated outside of 
Dran-View 7. 

The Dran-View 7 report writer has two modes: 
automatic and custom. The automatic mode creates a 
report very quickly in just three easy steps. With little 
user interaction you’ll have a report ready for your 
management, client or customer. 

The custom report mode offers you complete control 
of the content of your report. You can include or 
exclude any channel, parameter, statistical analysis, 
and even enable compliance reports to standards such 
as EN50160, G5/4, NVE and others. You can also create 
your own custom standard by adding your specific 
compliance information. Once you have created a 
report format to your liking, you can save it as a 
template and recall the report format for use in the 
future.  

HARMONICS – PRO, ENTERPRISE 

Dran-View 7 has powerful capabilities for harmonic 
analysis. Dran-View 7 displays trends and details of 
harmonic information recorded by the instrument, 
such as THD, Symmetrical Components, K factor, 
individual harmonics and more. Harmonic based data 
can be trended alongside any other parameter.  

If waveforms were recording during an event Dran-
View 7 can compute and display the harmonics of the 
recorded waveshapes by adding a DFT Chart to the 

waveform window using the Chart options in the 
Ribbon Insert tab. 

 
Figure 10 Harmonics Spectrum 

When viewing the properties of the harmonic display 
you can change the appearance, number of harmonics 
to display and other settings. 

HARMONICS/TIMEPLOT CALCULATOR – ENTERPRISE  

Dranetz instruments can record waveforms during both 
power quality events and by using the journal snapshot 
feature (periodic recordings). The Harmonic/Timelot 
tool can post-process these wavforms to compute 
additional (new) parameters including individual 
harmonics, VThd, IThd, Vrms, Irms, Frequency and 
others. These are in addition to any parameters 
recorded directly by the instrument.  

For example, when testing standby generator’s it’s 
common to require cycle by cycle frequency trends 
during generator start-up, ‘transient’ and other tests.  
Most instruments compute an average frequency, so 
cycle by cycle frequency usually isn’t available directly 
from the instrument data. By using the 
Harmonic/Timeplot Calculator, Dran-View 7 can 
compute the required cycle by cycle frequency using 
the waveshapes captured by the instrument during the 
generator start-up.       

    

TO CONTACT DRANETZ 
 Call 1-800-372-6832 (US and Canada) or 1-732-287-

3680 for Technical or Sales support. 

 To submit a support request online, please visit: 
https://www.dranetz.com/technical-support-
request/ 
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